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Introduction

Introduction
This section is a categorized compilation of tips for the MATLAB®

programmer. Each item is relatively brief to help you browse through them
and find information that is useful. Many of the tips include a reference to
specific MATLAB documentation that gives you more complete coverage of
the topic. You can find information on the following topics:

For suggestions on how to improve the performance of your MATLAB
programs, and how to write programs that use memory more efficiently, see
Improving Performance and Memory Usage
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Command and Function Syntax

In this section...

“Syntax Help” on page 1-4

“Command and Function Syntaxes” on page 1-4

“Command Line Continuation” on page 1-4

“Completing Commands Using the Tab Key” on page 1-5

“Recalling Commands” on page 1-5

“Clearing Commands” on page 1-6

“Suppressing Output to the Screen” on page 1-6

Syntax Help
For help about the general syntax of MATLAB® functions and commands, type

help syntax

Command and Function Syntaxes
You can enter MATLAB commands using either a command or function
syntax. It is important to learn the restrictions and interpretation rules for
both.

functionname arg1 arg2 arg3 % Command syntax
functionname('arg1','arg2','arg3') % Function syntax

For more information: See Calling Functions in the MATLAB Programming
Fundamentals documentation.

Command Line Continuation
You can continue most statements to one or more additional lines by
terminating each incomplete line with an ellipsis (...). Breaking down
a statement into a number of lines can sometimes result in a clearer
programming style.

sprintf ('Example %d shows a command coded on %d lines.\n', ...
exampleNumber, ...
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numberOfLines)

Note that you cannot continue an incomplete string to another line.

disp 'This statement attempts to continue a string ...
to another line, resulting in an error.'

For more information: See Entering Long Statements in the MATLAB
Desktop Tools and Development Environment documentation.

Completing Commands Using the Tab Key
You can save some typing when entering commands by entering only the first
few letters of the command, variable, property, etc. followed by the Tab key.
Typing the second line below (with T representing Tab) yields the expanded,
full command shown in the third line:

f = figure;
set(f, 'papTuT,'cT) % Type this line.
set(f, 'paperunits','centimeters') % This is what you get.

If there are too many matches for the string you are trying to complete, you
will get no response from the first Tab. Press Tab again to see all possible
choices:

set(f, 'paTT
PaperOrientation PaperPositionMode PaperType Parent
PaperPosition PaperSize PaperUnits

For more information: See Tab Completion in the Command Window in the
MATLAB Desktop Tools and Development Environment documentation

Recalling Commands
Use any of the following methods to simplify recalling previous commands
to the screen:

• To recall an earlier command to the screen, press the up arrow key one or
more times, until you see the command you want. If you want to modify the
recalled command, you can edit its text before pressing Enter or Return
to execute it.
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• To recall a specific command by name without having to scroll through your
earlier commands one by one, type the starting letters of the command,
followed by the up arrow key.

• Open the Command History window (View > Command History) to see
all previous commands. Double-click the command you want to execute.

For more information: See Recalling Previous Lines and Command History
Window in the MATLAB Desktop Tools and Development Environment
documentation.

Clearing Commands
If you have typed a command that you then decide not to execute, you can
clear it from the Command Window by pressing the Escape (Esc) key.

Suppressing Output to the Screen
To suppress output to the screen, end statements with a semicolon. This can
be particularly useful when generating large matrices.

A = magic(100); % Create matrix A, but do not display it.
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Help

In this section...

“Using the Help Browser” on page 1-7

“Help on Functions from the Help Browser” on page 1-8

“Help on Functions from the Command Window” on page 1-8

“Topical Help” on page 1-8

“Paged Output” on page 1-9

“Writing Your Own Help” on page 1-10

“Help for Subfunctions and Private Functions” on page 1-10

“Help for Methods and Overloaded Functions” on page 1-10

Using the Help Browser
Open the Help browser from the MATLAB® Command Window using one
of the following:

• Click the question mark symbol in the toolbar.

• Select Help > Product Help from the menu.

• Type the word doc at the command prompt.

Some of the features of the Help browser are listed below.

Feature Description

Product Filter Establish which products to find help on.

Contents Look up topics in the Table of Contents.

Index Look up help using the documentation Index.

Search Search the documentation for one or more words.

Demos See what demos are available; run selected demos.

Favorites Save bookmarks for frequently used Help pages.
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For more information: See Finding Information with the Help Browser in
the MATLAB Desktop Tools and Development Environment documentation.

Help on Functions from the Help Browser
To find help on any function from the Help browser, do either of the following:

• Select the Contents tab of the Help browser, open the Contents entry
labeled MATLAB, and find the two subentries shown below. Use one of
these to look up the function you want help on.

- Functions — Categorical List

- Functions — Alphabetical List

• Type doc functionname at the command line.

Help on Functions from the Command Window
Several types of help on functions are available from the Command Window:

• To list all categories that you can request help on from the Command
Window, just type

help

• To see a list of functions for one of these categories, along with a brief
description of each function, type help category. For example,

help datafun

• To get help on a particular function, type help functionname. For example,

help sortrows

Topical Help
In addition to the help on individual functions, you can get help on any of the
following topics by typing help topicname at the command line.

Topic Name Description

arith Arithmetic operators
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Topic Name Description

relop Relational and logical operators

punct Special character operators

slash Arithmetic division operators

paren Parentheses, braces, and bracket operators

precedence Operator precedence

datatypes MATLAB classes, their associated functions, and
operators that you can overload

lists Comma separated lists

strings Character strings

function_handle Function handles and the @ operator

debug Debugging functions

java Using Sun™ Java™ from within the MATLAB
software.

fileformats A list of readable file formats

changeNotification Microsoft® Windows® directory change notification

Paged Output
Before displaying a lengthy section of help text or code, put MATLAB into its
paged output mode by typing more on. This breaks up any ensuing display
into pages for easier viewing. Turn off paged output with more off.

Page through the displayed text using the space bar key. Or step through
line by line using Enter or Return. Discontinue the display by pressing
the Q key or Ctrl+C.
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Writing Your Own Help
Start each program you write with a section of text providing help on how and
when to use the function. If formatted properly, the MATLAB help function
displays this text when you enter

help functionname

MATLAB considers the first group of consecutive lines immediately following
the function definition line that begin with % to be the help section for the
function. The first line without % as the left-most character ends the help.

For more information: See Help Text in the MATLAB Desktop Tools and
Development Environment documentation.

Help for Subfunctions and Private Functions
You can write help for subfunctions using the same rules that apply to main
functions. To display the help for the subfunction mysubfun in file myfun.m,
type

help myfun>mysubfun

To display the help for a private function, precede the function name with
private/. To get help on private function myprivfun, type

help private/myprivfun

Help for Methods and Overloaded Functions
You can write help text for object-oriented class methods implemented with
M-files. Display help for the method by typing

help classname/methodname

where the file methodname.m resides in subdirectory @classname.

For example, if you write a plot method for a class named polynom, (where
the plot method is defined in the file @polynom/plot.m), you can display
this help by typing

help polynom/plot
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You can get help on overloaded MATLAB functions in the same way. To display
the help text for the eq function as implemented in matlab/iofun/@serial,
type

help serial/eq
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Development Environment

In this section...

“Workspace Browser” on page 1-12

“Using the Find and Replace Utility” on page 1-12

“Commenting Out a Block of Code” on page 1-13

“Creating M-Files from Command History” on page 1-13

“Editing M-Files in EMACS” on page 1-13

Workspace Browser
The Workspace browser is a graphical interface to the variables stored in
the MATLAB® base and function workspaces. You can view, modify, save,
load, and create graphics from workspace data using the browser. Select
View > Workspace to open the browser.

To view function workspaces, you need to be in debug mode.

For more information: See MATLAB Workspace in the MATLAB Desktop
Tools and Development Environment documentation.

Using the Find and Replace Utility
Find any word or phrase in a group of files using the Find and Replace utility.
Click View > Current Directory, and then click the binoculars icon at the
top of the Current Directory window.

When entering search text, you do not need to put quotes around a phrase.
In fact, parts of words, like win for windows, will not be found if enclosed in
quotes.

For more information: See Finding and Replacing Text in the Current File
in the MATLAB Desktop Tools and Development Environment documentation.
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Commenting Out a Block of Code
To comment out a block of text or code within the MATLAB editor,

1 Highlight the block of text you would like to comment out.

2 Holding the mouse over the highlighted text, select Text > Comment (or
Uncomment, to do the reverse) from the toolbar. (You can also get these
options by right-clicking the mouse.)

For more information: See Adding Comments in the MATLAB Desktop
Tools and Development Environment documentation.

Creating M-Files from Command History
If there is part of your current MATLAB session that you would like to put
into an M-file, this is easily done using the Command History window:

1 Open this window by selecting View > Command History.

2 Use Shift+Click or Ctrl+Click to select the lines you want to use.
MATLAB highlights the selected lines.

3 Right-click once, and select Create M-File from the menu that appears.
MATLAB creates a new Editor window displaying the selected code.

Editing M-Files in EMACS
If you use Emacs, you can download editing modes for editing M-files with
GNU-Emacs or with early versions of Emacs from the MATLAB Central Web
site:

http://www.mathworks.com/matlabcentral/

At this Web site, select File Exchange, and then Utilities > Emacs.

For more information: See General Preferences for the Editor/Debugger in
the MATLAB Desktop Tools and Development Environment documentation.
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M-File Functions

In this section...

“M-File Structure” on page 1-14

“Using Lowercase for Function Names” on page 1-14

“Getting a Function’s Name and Path” on page 1-15

“What M-Files Does a Function Use?” on page 1-15

“Dependent Functions, Built-Ins, Classes” on page 1-16

M-File Structure
An M-File consists of the components shown here:

function [x, y] = myfun(a, b, c) % Function definition line
% H1 line -- A one-line summary of the function's purpose.
% Help text -- One or more lines of help text that explain
% how to use the function. This text is displayed when
% the user types "help functionname".

% The Function body normally starts after the first blank line.
% Comments -- Description (for internal use) of what the
% function does, what inputs are expected, what outputs
% are generated. Typing "help functionname" does not display
% this text.

x = prod(a, b); % Start of Function code

For more information: See Basic Parts of an M-File in the MATLAB®

Programming Fundamentals documentation.

Using Lowercase for Function Names
Function names appear in uppercase in MATLAB help text only to make the
help easier to read. In practice, however, it is usually best to use lowercase
when calling functions.
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For M-file functions, case requirements depend on the case sensitivity of the
operating system you are using. As a rule, naming and calling functions using
lowercase generally makes your M-files more portable from one operating
system to another.

Getting a Function’s Name and Path
To obtain the name of an M-file that is currently being executed, use the
following function in your M-file code.

mfilename

To include the path along with the M-file name, use

mfilename('fullpath')

For more information: See the mfilename function reference page.

What M-Files Does a Function Use?
For a simple display of all M-files referenced by a particular function, follow
the steps below:

1 Type clear functions to clear all functions from memory (see Note below).

2 Execute the function you want to check. Note that the function arguments
you choose to use in this step are important, since you can get different
results when calling the same function with different arguments.

3 Type inmem to display all M-Files that were used when the function ran. If
you want to see what MEX-files were used as well, specify an additional
output, as shown here:

[mfiles, mexfiles] = inmem

Note clear functions does not clear functions locked by mlock. If you
have locked functions, (which you can check using inmem), unlock them with
munlock, and then repeat step 1.
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Dependent Functions, Built-Ins, Classes
For a much more detailed display of dependent function information, use the
depfun function. In addition to M-files, depfun shows which built-ins and
classes a particular function depends on.
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Function Arguments

In this section...

“Getting the Input and Output Arguments” on page 1-17

“Variable Numbers of Arguments” on page 1-17

“String or Numeric Arguments” on page 1-18

“Passing Arguments in a Structure” on page 1-18

“Passing Arguments in a Cell Array” on page 1-19

Getting the Input and Output Arguments
Use nargin and nargout to determine the number of input and output
arguments in a particular function call. Use nargchk and nargoutchk to
verify that your function is called with the required number of input and
output arguments.

function [x, y] = myplot(a, b, c, d)
disp(nargchk(2, 4, nargin)) % Allow 2 to 4 inputs
disp(nargoutchk(0, 2, nargout)) % Allow 0 to 2 outputs

x = plot(a, b);
if nargin == 4

y = myfun(c, d);
end

Variable Numbers of Arguments
You can call functions with fewer input and output arguments than you have
specified in the function definition, but not more. If you want to call a function
with a variable number of arguments, use the varargin and varargout
function parameters in the function definition.

This function returns the size vector and, optionally, individual dimensions:

function [s, varargout] = mysize(x)
nout = max(nargout, 1) - 1;
s = size(x);
for k = 1:nout
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varargout(k) = {s(k)};
end

Try calling it with

[s, rows, cols] = mysize(rand(4, 5))

String or Numeric Arguments
If you are passing only string arguments into a function, you can use
MATLAB® command syntax. All arguments entered in command syntax are
interpreted as strings.

strcmp string1 string1
ans =

1

When passing numeric arguments, it is best to use function syntax unless you
want the number passed as a string. The right-hand example below passes
the number 75 as the string, '75'.

isnumeric(75) isnumeric 75
ans = ans =

1 0

For more information: See in the MATLAB Programming Fundamentals
documentation.

Passing Arguments in a Structure
Instead of requiring an additional argument for every value you want to pass
in a function call, you can package them in a MATLAB structure and pass the
structure. Make each input you want to pass a separate field in the structure
argument, using descriptive names for the fields.

Structures allow you to change the number, contents, or order of the
arguments without having to modify the function. They can also be useful
when you have a number of functions that need similar information.
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Passing Arguments in a Cell Array
You can also group arguments into cell arrays. The disadvantage over
structures is that you do not have field names to describe each variable. The
advantage is that cell arrays are referenced by index, allowing you to loop
through a cell array and access each argument passed in or out of the function.
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Program Development

In this section...

“Planning the Program” on page 1-20

“Using Pseudo-Code” on page 1-20

“Selecting the Right Data Structures” on page 1-20

“General Coding Practices” on page 1-21

“Naming a Function Uniquely” on page 1-21

“The Importance of Comments” on page 1-21

“Coding in Steps” on page 1-22

“Making Modifications in Steps” on page 1-22

“Functions with One Calling Function” on page 1-22

“Testing the Final Program” on page 1-22

Planning the Program
When planning how to write a program, take the problem you are trying
to solve and break it down into a series of smaller, independent tasks.
Implement each task as a separate function. Try to keep functions fairly
short, each having a single purpose.

Using Pseudo-Code
You may find it helpful to write the initial draft of your program in a
structured format using your own natural language. This pseudo-code is often
easier to think through, review, and modify than using a formal programming
language, yet it is easily translated into a programming language in the next
stage of development.

Selecting the Right Data Structures
Look at what classes and data structures are available to you in MATLAB®

and determine which of those best fit your needs in storing and passing your
data.
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For more information: see in the Programming Fundamentals
documentation.

General Coding Practices
A few suggested programming practices:

• Use descriptive function and variable names to make your code easier to
understand.

• Order subfunctions alphabetically in an M-file to make them easier to find.

• Precede each subfunction with a block of help text describing what that
subfunction does. This not only explains the subfunctions, but also helps
to visually separate them.

• Do not extend lines of code beyond the 80th column. Otherwise, it will be
hard to read when you print it out.

• Use full Handle Graphics® property and value names. Abbreviated names
are often allowed, but can make your code unreadable. They also could be
incompatible in future releases of MATLAB.

Naming a Function Uniquely
To avoid choosing a name for a new function that might conflict with a name
already in use, check for any occurrences of the name using this command:

which -all functionname

For more information: See the which function reference page.

The Importance of Comments
Be sure to document your programs well to make it easier for you or someone
else to maintain them. Add comments generously, explaining each major
section and any smaller segments of code that are not obvious. You can add
a block of comments as shown here.

%---------------------------------------------
% This function computes the ... <and so on>
%---------------------------------------------
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For more information: See Comments in the MATLAB Programming
Fundamentals documentation.

Coding in Steps
Do not try to write the entire program all at once. Write a portion of it, and
then test that piece out. When you have that part working the way you want,
then write the next piece, and so on. It’s much easier to find programming
errors in a small piece of code than in a large program.

Making Modifications in Steps
When making modifications to a working program, do not make widespread
changes all at one time. It’s better to make a few small changes, test and
debug, make a few more changes, and so on. Tracking down a difficult bug
in the small section that you’ve changed is much easier than trying to find it
in a huge block of new code.

Functions with One Calling Function
If you have a function that is called by only one other function, put it in the
same M-file as the calling function, making it a subfunction.

For more information: See Subfunctions in the MATLAB Programming
Fundamentals documentation.

Testing the Final Program
One suggested practice for testing a new program is to step through the
program in the MATLAB debugger while keeping a record of each line that
gets executed on a printed copy of the program. Use different combinations of
inputs until you have observed that every line of code is executed at least once.
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Debugging

In this section...

“The MATLAB® Debug Functions” on page 1-23

“More Debug Functions” on page 1-23

“The MATLAB® Graphical Debugger” on page 1-24

“A Quick Way to Examine Variables” on page 1-24

“Setting Breakpoints from the Command Line” on page 1-25

“Finding Line Numbers to Set Breakpoints” on page 1-25

“Stopping Execution on an Error or Warning” on page 1-25

“Locating an Error from the Error Message” on page 1-25

“Using Warnings to Help Debug” on page 1-26

“Making Code Execution Visible” on page 1-26

“Debugging Scripts” on page 1-26

The MATLAB® Debug Functions
For a brief description of the main debug functions in MATLAB®, type

help debug

For more information: See Debugging Process and Features in the
MATLAB Desktop Tools and Development Environment documentation.

More Debug Functions
Other functions you may find useful in debugging are listed below.

Function Description

echo Display function or script code as it executes.

disp Display specified values or messages.

sprintf,
fprintf

Display formatted data of different types.
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Function Description

whos List variables in the workspace.

size Show array dimensions.

keyboard Interrupt program execution and allow input from
keyboard.

return Resume execution following a keyboard
interruption.

warning Display specified warning message.

error Display specified error message.

lasterr Return error message that was last issued.

lasterror Return last error message and related information.

lastwarn Return warning message that was last issued.

The MATLAB® Graphical Debugger
Learn to use the MATLAB graphical debugger. You can view the function
and its calling functions as you debug, set and clear breakpoints, single-step
through the program, step into or over called functions, control visibility into
all workspaces, and find and replace strings in your files.

Start out by opening the file you want to debug using File > Open or the
open function. Use the debugging functions available on the toolbar and
pull-down menus to set breakpoints, run or step through the program, and
examine variables.

For more information: See Debugging Process and Features in the
MATLAB Desktop Tools and Development Environment documentation.

A Quick Way to Examine Variables
To see the value of a variable from the Editor/Debugger window, hold the
mouse cursor over the variable name for a second or two. You will see the
value of the selected variable displayed.
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Setting Breakpoints from the Command Line
You can set breakpoints with dbstop in any of the following ways:

• Break at a specific M-file line number.

• Break at the beginning of a specific subfunction.

• Break at the first executable line in an M-file.

• Break when a warning, or error, is generated.

• Break if any infinite or NaN values are encountered.

For more information: See Setting Breakpoints in the MATLAB Desktop
Tools and Development Environment documentation.

Finding Line Numbers to Set Breakpoints
When debugging from the command line, a quick way to find line numbers for
setting breakpoints is to use dbtype. The dbtype function displays all or part
of an M-file, also numbering each line. To display delaunay.m, use

dbtype delaunay

To display only lines 35 through 41, use

dbtype delaunay 35:41

Stopping Execution on an Error or Warning
Use dbstop if error to stop program execution on any error and enter
debug mode. Use warning debug to stop execution on any warning and enter
debug mode.

For more information: See Backtrace and Verbose Modes in the MATLAB
Programming Fundamentals documentation.

Locating an Error from the Error Message
Click on the underlined text in an error message, and MATLAB opens the
M-file being executed in its editor and places the cursor at the point of error.
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For more information: See Finding Errors, Debugging, and Correcting
M-Files in the MATLAB Desktop Tools and Development Environment
documentation.

Using Warnings to Help Debug
You can detect erroneous or unexpected behavior in your programs by
inserting warning messages that MATLAB will display under the conditions
you specify. See the section on Warning Control in the MATLAB Programming
Fundamentals documentation to find out how to selectively enable warnings.

For more information: See the warning function reference page.

Making Code Execution Visible
An easy way to see the end result of a particular line of code is to edit the
program and temporarily remove the terminating semicolon from that line.
Then, run your program and the evaluation of that statement is displayed
on the screen.

For more information: See Finding Errors, Debugging, and Correcting
M-Files in the MATLAB Desktop Tools and Development Environment
documentation.

Debugging Scripts
Scripts store their variables in a workspace that is shared with the caller of
the script. So, when you debug a script from the command line, the script uses
variables from the base workspace. To avoid errors caused by workspace
sharing, type clear all before starting to debug your script to clear the
base workspace.
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Variables

In this section...

“Rules for Variable Names” on page 1-27

“Making Sure Variable Names Are Valid” on page 1-27

“Do Not Use Function Names for Variables” on page 1-28

“Checking for Reserved Keywords” on page 1-28

“Avoid Using i and j for Variables” on page 1-29

“Avoid Overwriting Variables in Scripts” on page 1-29

“Persistent Variables” on page 1-29

“Protecting Persistent Variables” on page 1-29

“Global Variables” on page 1-30

Rules for Variable Names
Although variable names can be of any length, MATLAB® uses only the
first N characters of the name, (where N is the number returned by the
function namelengthmax), and ignores the rest. Hence, it is important to make
each variable name unique in the first N characters to enable MATLAB to
distinguish variables. Also note that variable names are case sensitive.

N = namelengthmax
N =

63

For more information: See Naming Variables in the MATLAB
Programming Fundamentals documentation.

Making Sure Variable Names Are Valid
Before using a new variable name, you can check to see if it is valid with the
isvarname function. Note that isvarname does not consider names longer
than namelengthmax characters to be valid.

For example, the following name cannot be used for a variable since it begins
with a number.
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isvarname 8thColumn
ans =

0

For more information: See Naming Variables in the MATLAB
Programming Fundamentals documentation.

Do Not Use Function Names for Variables
When naming a variable, make sure you are not using a name that is already
used as a function name. If you do define a variable with a function name,
you will not be able to call that function until you clear the variable from
memory. (If it’s a MATLAB built-in function, then you will still be able to call
that function but you must do so using builtin.)

To test whether a proposed variable name is already used as a function name,
use

which -all name

For more information: See Potential Conflict with Function Names in the
MATLAB Programming Fundamentals documentation.

Checking for Reserved Keywords
MATLAB reserves certain keywords for its own use and does not allow you
to override them. Attempts to use these words may result in any one of a
number of error messages, some of which are shown here:

Error: Expected a variable, function, or constant, found "=".
Error: "End of Input" expected, "case" found.
Error: Missing operator, comma, or semicolon.
Error: "identifier" expected, "=" found.

Use the iskeyword function with no input arguments to list all reserved
words.
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Avoid Using i and j for Variables
MATLAB uses the characters i and j to represent imaginary units. Avoid
using i and j for variable names if you intend to use them in complex
arithmetic.

If you want to create a complex number without using i and j, you can use
the complex function.

Avoid Overwriting Variables in Scripts
MATLAB scripts store their variables in a workspace that is shared with
the caller of the script. When called from the command line, they share the
base workspace. When called from a function, they share that function’s
workspace. If you run a script that alters a variable that already exists in the
caller’s workspace, that variable is overwritten by the script.

For more information: See M-File Scripts in the MATLAB Programming
Fundamentals documentation.

Persistent Variables
To get the equivalent of a static variable in MATLAB, use persistent.
When you declare a variable to be persistent within a function, its value is
retained in memory between calls to that function. Unlike global variables,
persistent variables are known only to the function in which they are
declared.

For more information: See Persistent Variables in the MATLAB
Programming Fundamentals documentation.

Protecting Persistent Variables
You can inadvertently clear persistent variables from memory by either
modifying the function in which the variables are defined, or by clearing the
function with one of the following commands:

clear all
clear functions
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Locking the M-file in memory with mlock prevents any persistent variables
defined in the file from being reinitialized.

Global Variables
Use global variables sparingly. The global workspace is shared by all of
your functions and also by your interactive MATLAB session. The more
global variables you use, the greater the chances of unintentionally reusing a
variable name, thus leaving yourself open to having those variables change in
value unexpectedly. This can be a difficult bug to track down.

For more information: See Global Variables in the MATLAB Programming
Fundamentals documentation.
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Strings

In this section...

“Creating Strings with Concatenation” on page 1-31

“Comparing Methods of Concatenation” on page 1-31

“Store Arrays of Strings in a Cell Array” on page 1-32

“Converting Between Strings and Cell Arrays” on page 1-32

“Search and Replace Using Regular Expressions” on page 1-32

Creating Strings with Concatenation
Strings are often created by concatenating smaller elements together (e.g.,
strings, values, etc.). Two common methods of concatenating are to use the
MATLAB® concatenation operator ([]) or the sprintf function. The second
and third line below illustrate both of these methods. Both lines give the
same result:

numChars = 28;
s = ['There are ' int2str(numChars) ' characters here']
s = sprintf('There are %d characters here\n', numChars)

For more information: See and Converting from Numeric to String in the
MATLAB Programming Fundamentals documentation.

Comparing Methods of Concatenation
When building strings with concatenation, sprintf is often preferable to []
because

• It is easier to read, especially when forming complicated expressions

• It gives you more control over the output format

• It often executes more quickly

You can also concatenate using the strcat function, However, for simple
concatenations, sprintf and [] are faster.
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Store Arrays of Strings in a Cell Array
It is usually best to store an array of strings in a cell array instead of a
character array, especially if the strings are of different lengths. Strings in
a character array must be of equal length, which often requires padding the
strings with blanks. This is not necessary when using a cell array of strings
that has no such requirement.

The cellRecord below does not require padding the strings with spaces:

cellRecord = {'Allison Jones'; 'Development'; 'Phoenix'};

For more information: See Cell Arrays of Strings in the MATLAB
Programming Fundamentals documentation.

Converting Between Strings and Cell Arrays
You can convert between standard character arrays and cell arrays of strings
using the cellstr and char functions:

charRecord = ['Allison Jones'; 'Development '; ...
'Phoenix '];

cellRecord = cellstr(charRecord);

Also, a number of the MATLAB string operations can be used with either
character arrays, or cell arrays, or both:

cellRecord2 = {'Brian Lewis'; 'Development'; 'Albuquerque'};
strcmp(charRecord, cellRecord2)
ans =

0
1
0

For more information: See Converting to a Cell Array of Strings and in the
MATLAB Programming Fundamentals documentation.

Search and Replace Using Regular Expressions
Using regular expressions in MATLAB offers a very versatile way of searching
for and replacing characters or phrases within a string. See the help on these
functions for more information.
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Function Description

regexp Match regular expression.

regexpi Match regular expression, ignoring case.

regexprep Replace string using regular expression.

For more information: See “Regular Expressions” in the MATLAB
Programming Fundamentals documentation.
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Evaluating Expressions

In this section...

“Find Alternatives to Using eval” on page 1-34

“Assigning to a Series of Variables” on page 1-34

“Short-Circuit Logical Operators” on page 1-35

“Changing the Counter Variable within a for Loop” on page 1-35

Find Alternatives to Using eval
While the eval function can provide a convenient solution to certain
programming challenges, it is best to limit its use. The main reason is that
code that uses eval is often difficult to read and hard to debug. A second
reason is that eval statements cannot always be translated into C or C++
code by the MATLAB® Compiler.

If you are evaluating a function, it is more efficient to use feval than eval.
The feval function is made specifically for this purpose and is optimized to
provide better performance.

For more information: See MATLAB Technical Note 1103, “What Is the
EVAL Function, When Should I Use It, and How Can I Avoid It?” at URL
http://www.mathworks.com/support/tech-notes/1100/1103.html.

Assigning to a Series of Variables
One common pattern for creating variables is to use a variable name suffixed
with a number (e.g., phase1, phase2, phase3, etc.). We recommend using a
cell array to build this type of variable name series, as it makes code more
readable and executes more quickly than some other methods. For example:

for k = 1:800
phase{k} = expression;

end

1-34

http://www.mathworks.com/support/tech-notes/1100/1103.html


Evaluating Expressions

Short-Circuit Logical Operators
MATLAB has logical AND and OR operators (&& and ||) that enable you to
partially evaluate, or short-circuit, logical expressions. Short-circuit operators
are useful when you want to evaluate a statement only when certain
conditions are satisfied.

In this example, MATLAB does not execute the function myfun unless its
M-file exists on the current path.

comp = (exist('myfun.m') == 2) && (myfun(x) >= y)

For more information: See “Short-Circuit Operators” in the MATLAB
Programming Fundamentals documentation.

Changing the Counter Variable within a for Loop
You cannot change the value of the loop counter variable (e.g., the variable
k in the example below) in the body of a for loop. For example, this loop
executes just 10 times, even though k is set back to 1 on each iteration.

for k = 1:10
fprintf('Pass %d\n', k)
k = 1;

end

Although MATLAB does allow you to use a variable of the same name as the
loop counter within a loop, this is not a recommended practice.
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MATLAB® Path

In this section...

“Precedence Rules” on page 1-36

“File Precedence” on page 1-37

“Adding a Directory to the Search Path” on page 1-37

“Handles to Functions Not on the Path” on page 1-37

“Making Toolbox File Changes Visible to MATLAB®” on page 1-38

“Making Nontoolbox File Changes Visible to MATLAB®” on page 1-39

“Change Notification on Windows®” on page 1-39

Precedence Rules
When MATLAB® is given a name to interpret, it determines its usage by
checking the name against each of the entities listed below, and in the order
shown:

1 Variable

2 Subfunction

3 Private function

4 Class constructor

5 Overloaded method

6 M-file in the current directory

7 M-file on the path, or MATLAB built-in function

If you have two or more M-files on the path that have the same name,
MATLAB selects the function that has its M-file in the directory closest to the
beginning of the path string.

For more information: See in the MATLAB Programming Fundamentals
documentation.
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File Precedence
If you refer to a file by its filename only (leaving out the file extension), and
there is more than one file of this name in the directory, MATLAB selects the
file to use according to the following precedence:

1 MEX-file

2 MDL-file (Simulink® model)

3 P-Code file

4 M-file

For more information: See in the MATLAB Programming Fundamentals
documentation.

Adding a Directory to the Search Path
To add a directory to the search path, use either of the following:

• At the toolbar, select File > Set Path.

• At the command line, use the addpath function.

You can also add a directory and all of its subdirectories in one operation
by either of these means. To do this from the command line, use genpath
together with addpath. The online help for the genpath function shows how
to do this.

This example adds /control and all of its subdirectories to the MATLAB path:

addpath(genpath('K:/toolbox/control'))

For more information: See Search Path in the MATLAB Desktop Tools and
Development Environment documentation.

Handles to Functions Not on the Path
You cannot create function handles to functions that are not on the MATLAB
path. But you can achieve essentially the same thing by creating the handles
through a script file placed in the same off-path directory as the functions.
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If you then run the script, using run path/script, you will have created
the handles that you need.

For example,

1 Create a script in this off-path directory that constructs function handles
and assigns them to variables. That script might look something like this:

File E:/testdir/createFhandles.m
fhset = @setItems
fhsort = @sortItems
fhdel = @deleteItem

2 Run the script from your current directory to create the function handles:

run E:/testdir/createFhandles

3 You can now execute one of the functions by means of its handle.

fhset(item, value)

Making Toolbox File Changes Visible to MATLAB®

Unlike functions in user-supplied directories, M-files (and MEX-files) in the
matlabroot/toolbox directories are not time-stamp checked, so MATLAB
does not automatically see changes to them. If you modify one of these
files, and then rerun it, you may find that the behavior does not reflect the
changes that you made. This is most likely because MATLAB is still using the
previously loaded version of the file.

To force MATLAB to reload a function from disk, you need to explicitly clear
the function from memory using clear functionname. Note that there are
rare cases where clear will not have the desired effect, (for example, if the
file is locked, or if it is a class constructor and objects of the given class exist
in memory).

Similarly, MATLAB does not automatically detect the presence of new files
in matlabroot/toolbox directories. If you add (or remove) files from these
directories, use rehash toolbox to force MATLAB to see your changes. Note
that if you use the MATLAB Editor to create files, these steps are unnecessary,
as the Editor automatically informs MATLAB of such changes.
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Making Nontoolbox File Changes Visible to MATLAB®

For M-files outside of the toolbox directories, MATLAB sees the changes made
to these files by comparing timestamps and reloads any file that has changed
the next time you execute the corresponding function.

If MATLAB does not see the changes you make to one of these files, try
clearing the old copy of the function from memory using clear functionname.
You can verify that MATLAB has cleared the function using inmem to list all
functions currently loaded into memory.

Change Notification on Windows®

If MATLAB, running on Windows®, is unable to see new files or changes
you have made to an existing file, the problem may be related to operating
system change notification handles.

Type the following for more information:

help changeNotification
help changeNotificationAdvanced
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Program Control

In this section...

“Using break, continue, and return” on page 1-40

“Using switch Versus if” on page 1-41

“MATLAB® case Evaluates Strings” on page 1-41

“Multiple Conditions in a case Statement” on page 1-41

“Implicit Break in switch-case” on page 1-41

“Variable Scope in a switch” on page 1-42

“Catching Errors with try-catch” on page 1-42

“Nested try-catch Blocks” on page 1-43

“Forcing an Early Return from a Function” on page 1-43

Using break, continue, and return
It’s easy to confuse the break, continue, and return functions as they are
similar in some ways. Make sure you use these functions appropriately.

Function Where to Use It Description

break for or while loops Exits the loop in which it
appears. In nested loops,
control passes to the next
outer loop.

continue for or while loops Skips any remaining
statements in the current
loop. Control passes to next
iteration of the same loop.

return Anywhere Immediately exits the
function in which it appears.
Control passes to the caller
of the function.
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Using switch Versus if
It is possible, but usually not advantageous, to implement switch-case
statements using if-elseif instead. See pros and cons in the table.

switch-case Statements if-elseif Statements

Easier to read. Can be difficult to read.

Can compare strings of different
lengths.

You need strcmp to compare strings
of different lengths.

Test for equality only. Test for equality or inequality.

MATLAB® case Evaluates Strings
A useful difference between switch-case statements in MATLAB® and C is
that you can specify string values in MATLAB case statements, which you
cannot do in C.

switch(method)
case 'linear'

disp('Method is linear')
case 'cubic'

disp('Method is cubic')
end

Multiple Conditions in a case Statement
You can test against more than one condition with switch. The first case
below tests for either a linear or bilinear method by using a cell array
in the case statement.

switch(method)
case {'linear', 'bilinear'}

disp('Method is linear or bilinear')
case (<and so on>)

end

Implicit Break in switch-case
In C, if you do not end each case with a break statement, code execution
falls through to the following case. In MATLAB, case statements do not fall
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through; only one case may execute. Using break within a case statement is
not only unnecessary, it is also invalid and generates a warning.

In this example, if result is 52, only the first disp statement executes, even
though the second is also a valid match:

switch(result)
case 52

disp('result is 52')
case {52, 78}

disp('result is 52 or 78')
end

Variable Scope in a switch
Since MATLAB executes only one case of any switch statement, variables
defined within one case are not known in the other cases of that switch
statement. The same holds true for if-elseif statements.

In these examples, you get an error when choice equals 2, because x is
undefined.

-- SWITCH-CASE -- -- IF-ELSEIF --
switch choice

case 1 if choice == 1
x = -pi:0.01:pi; x = -pi:0.01:pi;

case 2 elseif choice == 2
plot(x, sin(x)); plot(x, sin(x));

end end

Catching Errors with try-catch
When you have statements in your code that could possibly generate
unwanted results, put those statements into a try-catch block that will catch
any errors and handle them appropriately.

The example below shows a try-catch block within a function that multiplies
two matrices. If a statement in the try segment of the block fails, control
passes to the catch segment. In this case, the catch statements check
the error message that was issued (returned by lasterr) and respond
appropriately.
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try
X = A * B

catch
errmsg = lasterr;
if(strfind(errmsg, 'Inner matrix dimensions'))

disp('** Wrong dimensions for matrix multiply')
end

For more information: See “The try-catch Statement” in the MATLAB
Programming Fundamentals documentation.

Nested try-catch Blocks
You can also nest try-catch blocks, as shown here. You can use this to
attempt to recover from an error caught in the first try section:

try
statement1 % Try to execute statement1

catch
try

statement2 % Attempt to recover from error
catch

disp 'Operation failed' % Handle the error
end

end

Forcing an Early Return from a Function
To force an early return from a function, place a return statement in the
function at the point where you want to exit. For example,

if <done>
return

end
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Save and Load

In this section...

“Saving Data from the Workspace” on page 1-44

“Loading Data into the Workspace” on page 1-44

“Viewing Variables in a MAT-File” on page 1-45

“Appending to a MAT-File” on page 1-45

“Save and Load on Startup or Quit” on page 1-46

“Saving to an ASCII File” on page 1-46

Saving Data from the Workspace
To save data from your workspace, you can do any of the following:

• Copy from the MATLAB® Command Window and paste into a text file.

• Record part of your session in a diary file, and then edit the file in a text
editor.

• Save to a binary or ASCII file using the save function.

• Save spreadsheet, scientific, image, or audio data with appropriate function.

• Save to a file using low-level file I/O functions (fwrite, fprintf, ...).

For more information: See Saving the Current Workspace in the MATLAB
Desktop Tools and Development Environment documentation, and “Using the
diary Function to Export Data” and “Using Low-Level File I/O Functions” in
the MATLAB Programming Fundamentals documentation.

Loading Data into the Workspace
Similarly, to load new or saved data into the workspace, you can do any
of the following:

• Enter or paste data at the command line.

• Create a script file to initialize large matrices or data structures.
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• Read a binary or ASCII file using load.

• Load spreadsheet, scientific, image, or audio data with appropriate
function.

• Load from a file using low-level file I/O functions (fread, fscanf, ...).

For more information: See Loading a Saved Workspace and Importing
Data in the MATLAB Development Environment documentation, and “Using
Low-Level File I/O Functions” in the MATLAB Programming Fundamentals
documentation.

Viewing Variables in a MAT-File
To see what variables are saved in a MAT-file, use who or whos as shown
here (the .mat extension is not required). who returns a cell array and whos
returns a structure array.

mydataVariables = who('-file', 'mydata.mat');

Appending to a MAT-File
To save additional variables to an existing MAT-file, use

save matfilename -append

Any variables you save that do not yet exist in the MAT-file are added to
the file. Any variables you save that already exist in the MAT-file overwrite
the old values.

Note Saving with the -append switch does not append additional elements to
an array that is already saved in a MAT-file. See the example below.

In this example, the second save operation does not concatenate new elements
to vector A, (making A equal to [1 2 3 4 5 6 7 8]) in the MAT-file. Instead,
it replaces the 5 element vector, A, with a 3 element vector, also retaining all
other variables that were stored on the first save operation.

A = [1 2 3 4 5]; B = 12.5; C = rand(4);
save savefile;
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A = [6 7 8];
save savefile A -append;

Save and Load on Startup or Quit
You can automatically save your variables at the end of each MATLAB session
by creating a finish.m file to save the contents of your base workspace every
time you quit MATLAB. Load these variables back into your workspace at the
beginning of each session by creating a startup.m file that uses the load
function to load variables from your MAT-file.

For more information: See the startup and finish function reference
pages.

Saving to an ASCII File
When you save matrix data to an ASCII file using save -ascii, MATLAB
combines the individual matrices into one collection of numbers. Variable
names are not saved. If this is not acceptable for your application, use
fprintf to store your data instead.

For more information: See “Exporting Delimited ASCII Data Files”.
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Files and Filenames

In this section...

“Naming M-files” on page 1-47

“Naming Other Files” on page 1-47

“Passing Filenames as Arguments” on page 1-48

“Passing Filenames to ASCII Files” on page 1-48

“Determining Filenames at Run-Time” on page 1-48

“Returning the Size of a File” on page 1-48

Naming M-files
M-file names must start with an alphabetic character, may contain any
alphanumeric characters or underscores, and must be no longer than
the maximum allowed M-file name length (returned by the function
namelengthmax).

N = namelengthmax
N =

63

Since variables must obey similar rules, you can use the isvarname function
to check whether a filename (minus its .m file extension) is valid for an M-file.

isvarname mfilename

Naming Other Files
The names of other files that MATLAB® interacts with (e.g., MAT, MEX, and
MDL-files) follow the same rules as M-files, but may be of any length.

Depending on your operating system, you may be able to include certain
nonalphanumeric characters in your filenames. Check your operating system
manual for information on valid filename restrictions.
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Passing Filenames as Arguments
In MATLAB commands, you can specify a filename argument using the
MATLAB command or function syntax. For example, either of the following
are acceptable. (The .mat file extension is optional for save and load).

load mydata.mat % Command syntax
load('mydata.mat') % Function syntax

If you assign the output to a variable, you must use the function syntax.

savedData = load('mydata.mat')

Passing Filenames to ASCII Files
ASCII files are specified as follows. Here, the file extension is required.

load mydata.dat -ascii % Command syntax
load('mydata.dat','-ascii') % Function syntax

Determining Filenames at Run-Time
There are several ways that your function code can work on specific files
without you having to hardcode their filenames into the program. You can

• Pass the filename in as an argument

function myfun(datafile)

• Prompt for the filename using the input function

filename = input('Enter name of file: ', 's');

• Browse for the file using the uigetfile function

[filename, pathname] =
uigetfile('*.mat', 'Select MAT-file');

For more information: See the input and uigetfile function reference
pages.

Returning the Size of a File
Two ways to have your program determine the size of a file are shown here.
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-- METHOD #1 -- -- METHOD #2 --
s = dir('myfile.dat'); fid = fopen('myfile.dat');
filesize = s.bytes fseek(fid, 0, 'eof');

filesize = ftell(fid)
fclose(fid);

The dir function also returns the filename (s.name), last modification date
(s.date), and whether or not it’s a directory (s.isdir).

(The second method requires read access to the file.)

For more information: See the fopen, fseek, ftell, and fclose function
reference pages.
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Input/Output

In this section...

“File I/O Function Overview” on page 1-50

“Common I/O Functions” on page 1-50

“Readable File Formats” on page 1-51

“Using the Import Wizard” on page 1-51

“Loading Mixed Format Data” on page 1-51

“Reading Files with Different Formats” on page 1-52

“Reading ASCII Data into a Cell Array” on page 1-52

“Interactive Input into Your Program” on page 1-52

For more information and examples on importing and exporting data, see
Technical Note 1602:

http://www.mathworks.com/support/tech-notes/1600/1602.html

File I/O Function Overview
For a good overview of MATLAB® file I/O functions, use the online “Functions
— Categorical List” reference. In the Help browser Contents, select
MATLAB > Functions — Categorical List, and then click File I/O.

Common I/O Functions
The most commonly used, high-level, file I/O functions in MATLAB are save
and load. For help on these, type doc save or doc load.

Functions for I/O to text files with delimited values are textread, dlmread,
dlmwrite. Functions for I/O to text files with comma-separated values are
csvread, csvwrite.

For more information: See Text Files in the MATLAB “Functions —
Categorical List” reference documentation.
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Readable File Formats
Type doc fileformats to see a list of file formats that MATLAB can read,
along with the associated MATLAB functions.

Using the Import Wizard
A quick method of importing text or binary data from a file (e.g., Excel files)
is to use the MATLAB Import Wizard. Open the Import Wizard with the
command, uiimport filename or by selecting File > Import Data at the
Command Window.

Specify or browse for the file containing the data you want to import and
you will see a preview of what the file contains. Select the data you want
and click Finish.

For more information: See “Using the Import Wizard” in the MATLAB
Programming Fundamentals documentation.

Loading Mixed Format Data
To load data that is in mixed formats, use textread instead of load. The
textread function lets you specify the format of each piece of data.

If the first line of file mydata.dat is

Sally 12.34 45

Read the first line of the file as a free format file using the % format:

[names, x, y] = textread('mydata.dat', '%s %f %d', 1)

returns

names =
'Sally'

x =
12.34000000000000

y =
45
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Reading Files with Different Formats
Attempting to read data from a file that was generated on a different platform
may result in an error because the binary formats of the platforms may differ.
Using the fopen function, you can specify a machine format when you open
the file to avoid these errors.

Reading ASCII Data into a Cell Array
A common technique used to read an ASCII data file into a cell array is

[a,b,c,d] = textread('data.txt', '%s %s %s %s');
mydata = cellstr([a b c d]);

For more information: See the textread and cellstr function reference
pages.

Interactive Input into Your Program
Your program can accept interactive input from users during execution. Use
the input function to prompt the user for input, and then read in a response.
When executed, input causes the program to display your prompt, pause
while a response is entered, and then resume when the Enter key is pressed.
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Starting MATLAB®

Getting MATLAB® to Start Up Faster
Here are some things that you can do to make MATLAB® start up faster.

• Make sure toolbox path caching is enabled.

• Make sure that the system on which MATLAB is running has enough RAM.

• Choose only the windows you need in the MATLAB desktop.

• Close the Help browser before exiting MATLAB. When you start your next
session, MATLAB will not open the Help browser, and thus will start faster.

• If disconnected from the network, check the LM_LICENSE_FILE variable.
See http://www.mathworks.com/support/solutions/data/1-17VEB.html for a
more detailed explanation.

For more information: See Toolbox Path Caching in MATLAB in the
MATLAB Desktop Tools and Development Environment documentation.
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Operating System Compatibility

In this section...

“Executing O/S Commands from MATLAB®” on page 1-54

“Searching Text with grep” on page 1-54

“Constructing Paths and Filenames” on page 1-54

“Finding the MATLAB® Root Directory” on page 1-55

“Temporary Directories and Filenames” on page 1-55

Executing O/S Commands from MATLAB®

To execute a command from your operating system prompt without having to
exit MATLAB®, precede the command with the MATLAB ! operator.

On Windows®, you can add an ampersand (&) to the end of the line to make
the output appear in a separate window.

For more information: See Running External Programs in the MATLAB
Desktop Tools and Development Environment documentation, and the system
and dos function reference pages.

Searching Text with grep
grep is a powerful tool for performing text searches in files on UNIX® systems.
To grep from within MATLAB, precede the command with an exclamation
point (!grep).

For example, to search for the word warning, ignoring case, in all M-files of
the current directory, you would use

!grep -i 'warning' *.m

Constructing Paths and Filenames
Use the fullfile function to construct path names and filenames rather
than entering them as strings into your programs. In this way, you always
get the correct path specification, regardless of which operating system you
are using at the time.
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Finding the MATLAB® Root Directory
The matlabroot function returns the location of the MATLAB installation
on your system. Use matlabroot to create a path to MATLAB and toolbox
directories that does not depend on a specific platform or MATLAB version.

The following example uses matlabroot with fullfile to return a
platform-independent path to the general toolbox directory:

fullfile(matlabroot,'toolbox','matlab','general')

Temporary Directories and Filenames
If you need to locate the directory on your system that has been designated to
hold temporary files, use the tempdir function. tempdir returns a string that
specifies the path to this directory.

To create a new file in this directory, use the tempname function. tempname
returns a string that specifies the path to the temporary file directory, plus a
unique filename.

For example, to store some data in a temporary file, you might issue the
following command first.

fid = fopen(tempname, 'w');
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Demos

Demos Available with MATLAB®

MATLAB® comes with a wide array of visual demonstrations to help you see
the extent of what you can do with the product. To start running any of the
demos, simply type demo at the MATLAB command prompt. Demos cover the
following major areas:

• MATLAB

• Toolboxes

• Simulink

• Blocksets

• Real-Time Workshop®

• Stateflow®

For more information: See Demos in the Help Browser in the MATLAB
Desktop Tools and Development Environment documentation, and the demo
function reference page.
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For More Information

In this section...

“Current CSSM” on page 1-57

“Archived CSSM” on page 1-57

“MATLAB® Technical Support” on page 1-57

“Tech Notes” on page 1-57

“MATLAB® Central” on page 1-57

“MATLAB® Newsletters (Digest, News & Notes)” on page 1-57

“MATLAB® Documentation” on page 1-58

“MATLAB® Index of Examples” on page 1-58

Current CSSM

http://www.mathworks.com/matlabcentral/newsreader

Archived CSSM

http://mathforum.org/kb/forum.jspa?forumID=80

MATLAB® Technical Support

http://www.mathworks.com/support/

Tech Notes

http://www.mathworks.com/support/tech-notes/list_all.html

MATLAB® Central

http://www.mathworks.com/matlabcentral/

MATLAB® Newsletters (Digest, News & Notes)

http://www.mathworks.com/company/newsletters/index.html
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MATLAB® Documentation

http://www.mathworks.com/access/helpdesk/help/helpdesk.html

MATLAB® Index of Examples

http://www.mathworks.com/access/helpdesk/help/techdoc/demo_example.shtml
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